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Saisie de texte
Capturez du texte sur votre écran et collez-le dans un autre programme.

Capture de texte
1. Dans la fenêtre de capture, cliquez sur l’onglet Image.

2. Dans la liste déroulante Sélection, sélectionnez Saisie de texte.

Certaines options ne peuvent pas être utilisées lorsque la fonction Saisie de texte est

sélectionnée.

3. Cliquez sur le bouton Capture ou appuyez sur la touche Impression écran (Windows) ou sur
Maj+Ctrl+C (Mac).

4. Le pointeur orange s’affiche. Cliquez et faites glisser la souris pour sélectionner la zone voulue à l’écran.

La capture s’ouvre dans Snagit Editor, où vous pouvez prévisualiser et copier le texte.

Recherche de texte dans une image
Recherchez, copiez et collez le texte d’une image.
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Saisie de texte à partir d’une sélection
Capturez le texte d’une partie spécifique de votre image.

Pour améliorer la précision et la qualité de la reconnaissance de texte, utilisez la sélection Saisie de

texte.

1. Dans Snagit Editor, cliquez sur l’outil Sélection.

2. Cliquez et faites glisser la souris sur le canevas pour sélectionner le texte.

3. Cliquez avec le bouton droit de la souris sur la zone sélectionnée et choisissez Saisie de texte.

4. Dans la fenêtre de texte, cliquez sur le bouton Tout copier.
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SurMac, activez l’option Convertir en texte brut pour supprimer la mise en forme avant de

copier le texte.

Vous pouvez coller le texte dans un éditeur de texte tel que Notepad ou un e-mail.

Saisie de la totalité du texte
Capturez tout le texte reconnaissable dans votre image.

1. Dans Snagit Editor, cliquez sur le bouton Saisie de texte.

Cet outil n’est pas visible par défaut. SélectionnezPlus > Personnaliser la barre d’outils. Faites

glisser l’élément Saisie de texte dans la barre d’outils.

2. Dans la fenêtre de texte, cliquez sur le bouton Tout copier.
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Vous pouvez coller le texte dans un éditeur de texte tel que Notepad ou un e-mail.

Modification d’un texte sélectionné
Vous pouvez corriger les erreurs typographiques ou modifier la police ou la couleur du texte de votre image.

1. Dans Snagit Editor, cliquez sur l’outil Sélection.

2. Cliquez et faites glisser la souris sur le canevas pour sélectionner du texte.

3. Cliquez avec le bouton droit de la souris sur la sélection, puis sélectionnezModifier le texte.

4. Cliquez sur la zone de texte pour afficher lemenu flottant et modifier le texte.
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Smart Move
Identifiez instantanément plusieurs objets pouvant êtremodifiés dans l’image. Ceci comprend les formes aux

bords définis, les chaînes de texte et d’autres éléments de l’image pouvant être identifiés séparément ou

regroupés.

Recherche et modification d’objets et de texte
1. Dans la barre d’outils de Snagit Editor, cliquez pour sélectionner l’outil Déplacement.

2. Dans les propriétés de l’outil, activez l’option Smart Move.

3. Des poignées de sélection apparaissent sur les objets pouvant être déplacés lorsque vous les survolez
avec la souris. Cliquez sur un objet pour lemodifier.

Pour identifier davantage d’objets à modifier, faites glisser le curseurDétail.

4. Pourmodifier les objets et le texte :

l Cliquez sur l’objet et faites-le glisser à l’emplacement voulu.

l Cliquez avec le bouton droit de la souris et sélectionnez Supprimer pour supprimer un objet.

l Double-cliquez dans la zone de texte pourmodifier le texte.

Suppression ou modification d’un texte sélectionné
1. Dans Snagit Editor, cliquez sur l’outil Sélection.

2. Cliquez sur le canevas et faites glisser le curseur de la souris pour sélectionner une zone contenant un
texte à supprimer ou remplacer.
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3. Cliquez avec le bouton droit de la souris sur la sélection, puis choisissezModifier le texte.

4. Cliquez dans la zone de texte pourmodifier le texte.
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Introduction à la capture
Vous pouvez effectuer une capture rapide, une capture d’écran personnalisée ou un enregistrement vidéo à

partir de la fenêtre de capture.

Ouvrir la fenêtre de capture :

l SousWindows, cliquez sur l’icône Snagit dans la barre des tâches ou la zone de notification.

l SurMac, cliquez sur l’icône dans la barre demenus.

l Dans Snagit Editor, cliquez sur le bouton Capture.

Conseil de pro : Pour enregistrer les paramètres de capture en vue de leur future utilisation,
sélectionnez la liste déroulante d’ajout de présélection >Nouvelle présélection à partir des
paramètres actifs. Vous pouvez également définir un raccourci. Voir Création de présélections.
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Capture d’une image
1. Dans la fenêtre de capture, sélectionnez l’onglet All-in-One ou Image.

2. Cliquez sur le bouton Capture ou appuyez sur la touche Impression écran (Windows) ou sur
Ctrl+Maj+C (Mac).

3. Le pointeur orange s’affiche.

Pour activer/désactiver la loupe de capture, appuyez sur la toucheM du clavier.

Effectuez l’une des opérations suivantes pour sélectionner la zone à capturer :

l Plein écran : cliquez sur le bouton Plein écran pour capturer l’intégralité de l’écran.

l Fenêtre : déplacez le curseur sur la fenêtre pour effectuer la capture. Lorsqu’une bordure
pointillée orange s’affiche autour de la fenêtre, cliquez pour sélectionner la zone en
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pointillés.

l Zone : cliquez et faites glisser la souris pour sélectionner la zone voulue à l’écran.

l Défilement : pour capturer le contenu qui s’étend au-delà de l’écran, utilisez les flèches de
défilement. Voir Capture avec défilement.

4. Pourmodifier la zone sélectionnée, effectuez l’une des opérations suivantes :

l Pour ajuster la taille de la sélection, faites glisser les poignées.

l Pour entrer une taille spécifique, saisissez les dimensions personnalisées en pixels dans les
champsde largeur et de hauteur.

l Pour déplacer la zone sélectionnée à l’écran, cliquez dessus et faites-la glisser vers
l’emplacement voulu.

5. Si elle s’effectue depuis l’onglet Image, la capture s’ouvre dans Snagit Editor, où vous pouvez la
visualiser, la modifier et la partager.

Si la capture s’effectue depuis l’onglet All-in-One :

l Cliquez sur le bouton Capture pour finaliser la capture.

Votre image s’ouvre dans Snagit Editor. Voir Snagit Editor.

Pour enregistrer une vidéo de votre écran, lancez la capture à partir de l’onglet Vidéo ou utilisez le
bouton Enregistrer une vidéo après avoir sélectionné la zone de l’écran à capturer sous l’onglet All-
in-One. Voir Enregistrement de vidéos.
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Paramètres de capture

Option Description

Copiez la capture dans le Presse-papiers pour ensuite la coller
rapidement dans un autre programme ou à un autre
emplacement.

Ouvrez la capture dans Snagit Editor pour prévisualiser, modifier

et partager l’image ou la vidéo.

Désactivez cette option pour ne pas prévisualiser etmodifier la

capture dans Snagit Editor. Sélectionnez une option de partage

dans la fenêtre de capture pour partager automatiquement la

capture sur une destination.

Incluez le curseur dans la capture.

l Pour les captures d’image, le curseur est capturé en tant
qu’image vectorielle pouvant être déplacée, modifiée ou
supprimée de l’image.

l Pour les captures vidéo, il est recommandé de capturer le
curseur avec la vidéo pour montrer l’emplacement de
l’action en cours à l’écran.

Retardez le début de la capture de 5 secondes pour laisser plus de

temps de préparation avant la capture.

Après avoir cliqué sur le bouton Capture, un compte à rebours

s’affiche dans le coin inférieur droit de l’écran.

Options supplémentaires

En cas de capture All-in-One, cliquez sur l’icône des options

supplémentaires pour développer les options de partage.
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Option Description

Sélectionnez une option dans la liste déroulante Partage de la

fenêtre de capture pour partager la capture. Pour en savoir plus

les destinations de partage, voir Partage de captures.

l Lorsque l’option Aperçu dans Editor est désactivée, vous
devez cliquer sur le bouton Terminer dans Snagit Editor
pour envoyer la capture vers la destination sélectionnée.

l Lorsque l’option Aperçu dans Editor est désactivée, la
capture est automatiquement envoyée à la destination
sélectionnée à la fin de l’opération de capture.

Seules les destinations qui prennent en charge les

formats de fichier image et vidéo sont disponibles. Pour

afficher davantage de destinations de partage, utilisez

l’onglet Image, l’onglet Vidéo ou partagez la capture

depuis Snagit Editor.

Paramètres de capture d’imprimante Snagit (Windows)
Envoyez du contenu vers Snagit Editor à partir d’une application en utilisant la fonction d’impression de cette

application.

Configuration d’une imprimante Snagit

1. Dans la fenêtre de capture, sélectionnez Fichier > Préférences de capture > onglet Capture >
Paramètres de capture imprimante.

2. La boîte de dialogue Propriétés de sélection s’affiche. Sous l’onglet Imprimantes Snagit, sélectionnez
Snagit 2018 ou cliquez sur Ajouter une imprimante Snagit. Cliquez sur le bouton Propriétéspour
modifier les paramètres de sortie de l’imprimante.

3. Cliquez sur le boutonOK.
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Envoi de contenu vers Snagit Editor depuis une application

1. Dans l’application, sélectionnez Fichier > Imprimer (ou action équivalente pour l’application concernée).

2. Dans la liste d’imprimantes, sélectionnez Snagit 2018.

3. Cliquez surOK pour envoyer la capture vers Snagit Editor.
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Enregistrement de vidéos
Enregistrez une vidéo de l’écran en tant que vidéoMP4. Vous avez la possibilité d’enregistrer le son d’un

micro, le son du système et unewebcam. Utilisez les vidéos Snagit dans les cas suivants :

l guider le spectateur tout au long d’un processus ou pour résoudre un problème ;

l enregistrer une démonstration ou une vidéo didactique ;

l enregistrer une présentation en passant des diapositives de présentation à la vidéo de l’orateur et vice
versa ;

l envoyer des commentaires audio et visuels sous forme de vidéo ;

l enregistrer une petite partie d’une vidéo ou d’une animation en ligne.

Enregistrement d’une vidéo
1. Dans la fenêtre de capture, sélectionnez l’onglet Vidéo.

2. Cliquez sur le bouton Capture ou appuyez sur la touche Impression écran (Windows) ou sur
Ctrl+Maj+C (Mac).
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3. Le pointeur orange s’affiche. Cliquez et faites glisser la souris pour sélectionner la zone à enregistrer à
l’écran ou cliquez sur le bouton Plein écran pour sélectionner l’intégralité de l’écran.

4. Pourmodifier la zone sélectionnée, effectuez l’une des opérations suivantes :

l Faites glisser les poignées pour définir la sélection.

l Pour entrer une taille spécifique, saisissez les dimensions en pixels dans les champsde largeur et de
hauteur.

l Pour déplacer la zone sélectionnée à l’écran, cliquez sur celle-ci et faites-la glisser vers
l’emplacement voulu.
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Appuyez surG pour afficher les guides de sélection vidéo lors de la sélection d’une zone à

enregistrer. Voir Dimensions d'enregistrement (Résolution).

5. La barre d’outils Enregistrement vidéo s’affiche.

Il est possible d’activer et de désactiver les options de la barre d’outils en cliquant sur l’icône

correspondante avant et pendant l’enregistrement :

Pour activer lemicrophone ou la webcamsurmacOS 10.14, vous devez autoriser Snagit à y

accéder. Dans les Préférences Système, sélectionnez Sécurité et confidentialité > onglet

Confidentialité >Microphone ou Caméra et activez Snagit.

l Webcam : enregistrez une vidéo en direct depuis unewebcam connectée ou intégrée. Aucune
vidéo d’écran n’est pas enregistrée lorsque l’option dewebcamest activée.

l Son du système : enregistrez le son de votre ordinateur, par exemple, celui des alertes
d’applications ou celui des haut-parleurs de l’ordinateur.

l Son du micro : enregistrez le son du micro intégré de votre ordinateur ou d’un micro USB
connecté.

6. Pour lancer l’enregistrement, cliquez sur le bouton Enregistrement ou appuyez surMaj+F9.

7. Pour arrêter l’enregistrement, cliquez sur le bouton Stop ou appuyez surMaj+F10 (Windows) ou
Option+Maj+V (Mac).

La capture s’ouvre dans Snagit Editor, où vous pouvez la visualiser, la modifier et la partager.
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Si vous utilisez fréquemment lesmêmesdimensions vidéo ou paramètres d’enregistrement,

sauvegardez-les en tant que présélection pour les réutiliser par la suite. Voir Création de

présélections.

Paramètres de capture vidéo

Option Description

Enregistrer unewebcam intégrée ou autre caméra pendant la capture vidéo

L’option dewebcam permet de passer de l’affichage de l’enregistrement de la

webcam (webcam activée) à celui de l’enregistrement de l’écran (webcam

désactivée), et inversement, dans la capture vidéo.

Enregistrez le son à l’aide d’un microphone pendant la capture vidéo.

Enregistrez le son du système (les sons provenant des applications et des
sites Web) pendant la capture vidéo.

Ouvrez la capture dans Snagit Editor pour prévisualiser, modifier et partager

la vidéo.

Désactivez cette option pour ne pas prévisualiser etmodifier la capture dans

Snagit Editor. Sélectionnez une option de partage dans la fenêtre de capture

pour partager automatiquement la capture sur une destination.

Incluez le curseur dans la capture.

Pour les captures vidéo, il est recommandé de capturer le curseur
avec la vidéo pour montrer l’emplacement de l’action en cours à
l’écran.

Dimensions d’enregistrement (Résolution)
Pour créer des vidéos de qualité, réfléchissez aux dimensions d'enregistrement avant de lancer

l’enregistrement vidéo. Il est important de sélectionner les dimensions appropriées à la destination prévue

pour le partage de la vidéo. Snagit vous aide de différentes façon à sélectionner les dimensions appropriées

pour vos enregistrements vidéo.
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Sélection de la zone d’enregistrement vidéo
Snagit offre la flexibilité de réaliser d’enregistrer des dimensions personnalisées, un rapport hauteur/largeur

de 4:3 ou 16:9, l’intégralité de l’écran, une zone ou une fenêtre. Encadrez le contenu d’écran en

sélectionnant une zone d’enregistrement incluant uniquement le contenu approprié.

Sélection Description

Plein écran

Cliquez sur le bouton Plein écran.

Fenêtre

1. Passez le curseur sur la fenêtre à enregistrer.

2. Une bordure orange s’affiche autour de la fenêtre. Cliquez pour sélectionner.

Zone

Cliquez et faites glisser la souris pour sélectionner une zone de l’écran.

Maintenez la touche CTRL enfoncée et faites glisser la souris pour verrouiller la
sélection sur un rapport hauteur/largeur de 16:9, ou maintenez la toucheMAJ
enfoncée et faites glisser la souris pour la verrouiller sur un rapport hauteur/largeur
de 4:3.

Dimensions
personnalisées

1. Cliquez et faites glisser la souris pour sélectionner une zone de l’écran.

2. La barre d’outils s’affiche. Saisissez les dimensions personnalisées dans les champs de
largeur et de hauteur.
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Sélection de dimensions standard
Les guides vidéo de Snagit indiquent les dimensions standard ou recommandées (jusqu’à 1920x1080) pour les

destinations de partage vidéo courantes, telles que YouTube, les sitesWeb et les appareilsmobiles. Les guides

vidéo disponibles sont les suivants :

l 1080p : 1920x1080

l 720p : 1280x720

l 640x480

l 320X240

Si vous avez l’intention de partager votre vidéo sur une destination nécessitant des dimensions spécifiques de

vidéo, il est recommandé de réaliser l’enregistrement avec ces dimensions ou avec lemême rapport

hauteur/largeur que les dimensions recommandées.

1. Lors de la sélection d’une zone à enregistrer, appuyez surG pour activer et désactiver les guides de
sélection vidéo.

2. Cliquez et faites glisser la souris pour sélectionner la zone d’enregistrement. Le guide apparaît
vaguement lorsque vous faites glisser le curseur à proximité de l’une des dimensions standard.

3. Continuez à faire glisser le curseur jusqu’à ce que la bordure de la sélection mise en évidence
corresponde au guide.
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Snagit peut capturer l’intégralité du contenu d’un navigateurWeb ou d’une fenêtre d’application, y compris

le contenu qui s’étend au-delà de la zone visible dans la fenêtre.

Il existe deuxméthodes de capture avec défilement :

l Les flèches de défilement : elles permettent de faire automatiquement défiler la fenêtre
horizontalement, verticalement ou dans les deux sens, afin de capturer l’intégralité du contenu de la
fenêtre ou du navigateurWeb.

l La capture avec défilement panoramique : elle permet de faire défilermanuellement la zone à capturer
dans la fenêtre ou le navigateurWeb.

Capture avec flèches de défilement
1. Ouvrez ou configurez l’élément à capturer.

2. Dans la fenêtre de capture, cliquez sur All-in-One.

3. Cliquez sur le bouton Capture ou appuyez sur Impression écran (Windows) ou Ctrl+Maj+C (Mac).
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4. Les pointeurs oranges s’affichent. Déplacez le curseur dans la fenêtre.

Cliquez sur une flèche pour prendre une capture de la zone de défilement horizontal, de la zone de
défilement vertical ou de la zone de défilement intégrale.

Si les flèches de défilement ne s’affichent pas dans Snagit Mac, vérifiez que la capture avec

défilement est activée dans les préférences de capture.

La capture s’ouvre dans Snagit Editor, où vous pouvez la visualiser, la modifier et la partager.
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Capture avec défilement panoramique
1. Dans la fenêtre de capture, sélectionnez l’onglet All-in-One.

Vous avez également la possibilité d’utiliser la présélection de capture avec défilement

panoramique installée avec Snagit. Voir présélections.

2. Cliquez sur le bouton Capture ou appuyez sur Impression écran (Windows) ou Ctrl+Maj+C (Mac).

3. Les pointeurs oranges s’affichent. Cliquez et faites glisser la souris pour sélectionner une zone de la
fenêtre à l’écran. Voir Conseils sur la sélection d’une zone.

4. Cliquez sur le bouton de capture panoramique.

5. Dans la barre d’outils Panoramique, cliquez sur le bouton Lancer.

6. Dans la fenêtre, utilisez les barres de défilement ou cliquez et faites glisser la fonction de panoramique
pour visualiser le contenu de la fenêtre à capturer. Snagit capture tous les éléments affichés dans la
zone sélectionnée. Voir Conseils sur le défilement et la fonction de panoramique.

7. Pour arrêter la capture panoramique, cliquez sur le bouton Stop dans la barre d’outils Panoramique. Si
la barre d’outils est masquée, cliquez sur l’icône Fenêtre de capture dans la barre des tâches.

La capture s’ouvre dans Snagit Editor, où vous pouvez la visualiser, la modifier et la partager.
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Conseils sur la sélection d’une zone

l Agrandissez la fenêtre du navigateurWeb ou de l’application afin demieux visualiser son contenu
lorsque vous utilisez les flèches de défilement ou la fonction de panoramique pendant la capture.

l N’incluez pas la barre de défilement dans la sélection.

l Pensez à exclure de la capture les éléments superflus, tels que lesmarges vides, les publicités en ligne,
etc.

l Désactivez les barres d’outils flottantes avant la capture.

Conseils sur le défilement et la fonction de panoramique

l Le défilement doit être effectué demanière fluide, ni trop vite, ni trop lentement.

l Utilisez les flèches de défilement ou la fonction de panoramique dans une seule direction à la fois. Évitez
les zigzags.
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Snagit Capture Preferences and Keyboard
Shortcuts
To open the Snagit Preferences, select Snagit > Preferences. To learn more about the capture options, view

the following:

l Capture Tab

l Keyboard Tab

l Preferences allow you to apply custom settings for all image and video captures.

l General

l Capture

l Outputs

l Keyboard

l Advanced

l

Locate information about the General and Advanced tabs under Snagit Editor Preferences and
Shortcuts.

l Keyboard shortcuts allow you to press a combination of keys to quickly complete tasks in Snagit.

l Capture shortcuts

l Editor shortcuts

l

For Editor shortcuts see Snagit Editor Preferences and Shortcuts.

l

See Share Captures formore information on Outputs.
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Capture Preferences

Option Description

Hide Snagit when
capturing

Minimize Snagit during capture.

Show video

countdown
Displays a three second countdown before starting the video recording.

Show quick controls
in fullscreen
recordings

Displays theWebcam button and Pause button in the bottom right corner of the screen
during a fullscreen video recording.

Scrolling capture
This option only appears when Snagit's scrolling capture is disabled. Click the Enable button
to install additional options to improve Snagit's scrolling capture capabilities.

Downsample Retina
video recordings

Scales down Retina video recordings. It is recommended to enable this option.

If video quality is a concern, you may want to consider disabling this option. When disabled,

the text and graphics appear crisper, but the videomay result in larger file sizes and

dimensions.

Automatically start
video recording

Automatically start the video recording after selecting the video recording area.

By default, this option is disabled. You must click the Record button to start the recording.

System Audio
Component

The TechSmith Audio Capture Component allows you to record system audio (the sound
from your computer speakers) during a video capture.

Camera Select a built-in or connected camera device for recording camera video.

Microphone Select a built-in or connected audio device for recording microphone audio.

Input Level Measures the audio level for the selected microphone audio device.

Keyboard Preferences
To open the Snagit Preferences, select Snagit > Preferences > Keyboard tab.

You can change the following default shortcuts:

l All-in-OneCapture (Shift-Control-C)

l Image Capture (Shift-Control-S)

l VideoCapture (Shift-Control-V)
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l Window (Expose) Capture (Shift-Control-W)

l Menu Capture (Shift-Control-E)

l Pause/Resume Recording (Control-Shift-Space)

l Repeat Last Capture (Shift-Control-R)

Change a Default Keyboard Shortcut
1. Select Snagit > Preferences > Keyboard tab.

2. Click the keyboard shortcut button.

3. Press the desired key combination on the keyboard.

The new keyboard shortcut appears in the field

Capture Keyboard Shortcuts
The keyboard shortcuts for common commands are also listed in themenus. To complete an action, press

the shortcut keys indicated below.

Image Keyboard Shortcuts

Option Keyboard Shortcut

Global Capture Control-Shift-C

Video Selection Guides G

Magnifier M

Cancel Caputre Esc

Hide Capture Help H

Capture Fullscreen F

Capture Multiple Regions Hold the Command key

Scroll Horizontally R

Scroll Vertically D

Scroll Diagonally X

Image Capture Shift-Control-S
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Option Keyboard Shortcut

Expose (Window) Capture Shift-Control-W

Menu Capture Shift-Control-E

Repeat Last Capture Shift-Control-R

Video Keyboard Shortcuts

Option Keyboard Shortcut

Video Capture Control-Shift-V

Start Recording Control-Shift-Space

Pause/Resume Recording Control-Shift-Space

Stop Recording Control-Shift-V

Repeat Last Capture Shift-Control-R
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Création de présélections
Les présélectionsmémorisent automatiquement les paramètres de capture. Utilisez les présélections dans les

cas suivants :

l enregistrer les paramètres de capture couramment utilisés ;

l basculer rapidement d’un type de capture à un autre en fonction de la tâche à effectuer ;

l automatiser l’ajout d’effets ou les emplacements de partage des captures pendant la procédure de
capture.

Capture avec une présélection
1. Dans la fenêtre de capture, cliquez sur le bouton Présélections. La liste des présélections disponibles

s’affiche.

2. Passez le curseur sur la présélection voulue jusqu’à ce que le bouton rouge Lancer la capture avec la
présélection apparaisse. Cliquez sur ce bouton pour lancer la capture.

Conseil de pro : cliquez sur le champ Raccourci (Windows et Mac) pour saisir la combinaison de
touches à définir comme raccourci. Utilisez ce raccourci pour lancer une nouvelle capture avec les
paramètres que vous avez prédéfinis.
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Création d’une présélection
Ajoutez rapidement une nouvelle présélection à partir des paramètres actuellement sélectionnés.

1. Dans la fenêtre de capture, cliquez sur la liste déroulanteNouvelle présélection.

2. Sélectionnez l’optionNouvelle présélection à partir des paramètres actifsdans la liste déroulante. Une
nouvelle présélection est ajoutée à la liste des présélections enregistrée.

Vous pouvez aussi décider d’ajouter une présélection en choisissantNouvelle présélection,
puis en sélectionnant manuellement les paramètres de capture à ajouter à la présélection
dans la boîte de dialogue qui s’affiche.

3. Entrez un nompour la présélection et appuyez sur Entrée.

4. Pour définir un raccourci clavier, cliquez sur le champ Raccourci (Windows et Mac).

5. Appuyez sur la combinaison de touches voulue sur le clavier pour créer un raccourci.
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Modification d’une présélection
1. Dans la fenêtre de capture, cliquez sur le bouton Présélections. La liste des présélections disponibles

s’affiche.

2. Cliquez sur l’icône à droite du nomde la présélection et sélectionnez l’une des options dans lemenu
déroulant.

Organisation de la liste de présélections (Windows)
1. Passez le curseur sur la présélection voulue jusqu’à ce que l’icône s’affiche.

2. Cliquez sur l’icône et faites-la glisser pour déplacer la présélection vers le haut ou vers le bas dans la liste
de présélections.
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Partage de présélections
Importez et exportez des fichiers de présélection Snagit (.snagpresets) pour partager vos paramètres de

capture avec d’autres personnes.

Importation d’une présélection

1. Dans la fenêtre de capture, sélectionnez Fichier > Importer les présélections.

2. Sélectionnez un fichier de présélection Snagit (.snagpresets), puis cliquez surOuvrir. Ctrl+clic pour
sélectionner plusieurs présélections.

Snagit ajoute les présélections importées à la liste des présélections enregistrées.

Exportation d’une présélection

1. Dans la fenêtre de capture, cliquez sur le bouton Présélections.

2. La liste des présélections disponibles s’affiche. Cliquez sur l’icône à côté de la présélection à exporter,
puis sélectionnez Exporter.

3. La boîte de dialogue Enregistrer sous s’affiche. Sélectionnez un emplacement.

4. Entrez un nomde fichier.

5. Cliquez sur Enregistrer.
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Snagit Capture Preferences and Hotkeys
To open the Capture Preferences, selectCapture Window > File > Capture Preferences. To learn more about

the capture options, view the following:

l General Tab

l Capture Tab

l Hotkeys Tab

General Tab

Option Description

Run Snagit when
Windows starts

Open and run Snagit on computer startup.

Show OneClick

Displays the quick capture options as a tab at the top of the screen. The quick capture options
display when you hover the cursor over the blur bar.

Snagit theme Choose between the two Snagit interface color themes:Light or Dark.

Send anonymous
usage data

Send anonymous data on Snagit usage to help TechSmith improve future versions.

Automatically
check for updates

Automatically check for the latest version of Snagit when connected to the Internet.

Capture Tab

Option Description

Hide Snagit when capturing Minimize Snagit during capture.

Show magnifier
Show themagnifier when selecting an area to capture. Themagnifier helps to

capture pixel accuracy.
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Option Description

To hide themagnifier, press M.

Show video countdown Displays a three second countdown before starting the video recording.

Show quick controls in
fullscreen recordings

Displays theWebcam button and Pause button in the bottom right corner of the
screen during a fullscreen video recording.

Microphone Select a built-in or connected audio device for recording microphone audio.

Input level Measures the audio level for the selected microphone audio device.

Webcam Select a built-in or connected camera device for recording camera video.

Video Quality
Select the quality for video recordings. Higher video quality can result in larger file
sizes.

Hotkeys Tab
You can change the following default keyboard shortcuts under this tab:

l Show/Hide Snagit

l Repeat Last Capture

l VideoCapture Start/Pause/Resume

l VideoCapture Stop

CheckAllow Snagit to override other hotkey assignments so assigned hotkeys cannot be used by other

programswhen Snagit is running.
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Other Hotkeys

Image Capture Hotkeys

Option Hotkey

Global Capture PRINT SCREEN

Move Crosshairs 1 Pixel Arrow keys

Capture 1:1 Aspect Ratio
(Square)

Hold SHIFT

Region (16:9 aspect ratio)
Click and drag to select an area on the screen. Hold CTRL to lock the selection to a 16:9
aspect ratio.

Region (4:3 aspect ratio)
Click and drag to select an area on the screen. Hold CTRL+SHIFT to lock the selection
to a 4:3 aspect ratio.

Take a Capture ENTER

Start a Region Selection SHIFT+ENTER

Show/HideMagnifier M

Show/Hide Capture Help F1

Scroll Horizontally H

Scroll Vertically V

Scroll Diagonally B

End Multiple Image
Capture

Right-click on the screen

Repeat Last Capture
Take a capture using the last settings used for a capture.

To set a hotkey, select File > Capture Preferences > Hotkeys tab.

Show/Hide Snagit CTRL+SHIFT+X
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Video Capture Hotkeys

Option Hotkey

Pause/Resume Recording SHIFT+F9

Stop Recording SHIFT+F10

Change Global Capture Hotkey
1. Open the Capture window.

2. ClickPress a hotkey.

3. Press the desired key combination on the keyboard.

The new hotkey appears in the field.
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Introduction à Snagit Editor
Utilisez Snagit Editor pour prévisualiser, modifier et partager vos captures.

Ouverture de Snagit Editor
l Cliquez sur le boutonOuvrir Editor dans la fenêtre de capture.

l Dans la zone de notification, cliquez avec le bouton droit de la souris sur l’icône Snagit, puis
sélectionnezOuvrir Snagit Editor. (Windowsuniquement)
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Aperçu de Snagit Editor

Bibliothèque

Affichez et organisez l’historique de vos captures.

Voir Introduction à la bibliothèque.

Canevas

Zone de travail permettant de prévisualiser et demodifier les captures.

Voir Redimensionnement du canevas.

Conseils d’utilisation du canevas

l Pour modifier ultérieurement des objets pouvant être déplacés sur le canevas, enregistrez les images
en tant que fichiers SNAG ou SNAGPROJ.

l Faites glisser les poignées situées sur les bords d’une image afin d’agrandir l’espace de travail sur le
canevas.

l Lemotif en damier sur le canevas représente les zones transparentes de l’image. Pour conserver la
transparence, enregistrez l’image sous un format prenant en charge la transparence (CUR, GIF, ICO,
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PNG, TIF, SNAG ou SNAGPROJ).

l Pour modifier la couleur d’arrière-plan du canevas (Windows) :

l Cliquez avec le bouton droit de la souris sur le canevas, choisissez Couleur du canevas, puis
sélectionnez une couleur.

l Ou bien, sélectionnez Image > Couleur du canevas.

l Activez l’alignement sur le canevas pour aligner des objets et des zones de texte :

l Sélectionnez Image > Alignement sur le canevas.

l Vous avez aussi la possibilité de cliquer avec le bouton droit de la souris sur le canevas, puis de
sélectionner Alignement sur le canevas.

Barre d’outils

Cliquez pour sélectionner un outil d’édition. Les outils permettent d’annoter, demodifier et d’améliorer les

captures d’image. Vous pouvez personnaliser l’organisation et les outils disponibles de la barre d’outils.

Voir Outils d’édition.

Partage

Partagez les captures sur un réseau social ou d’autres applications.

Voir Partage de captures.

Styles rapides

Appliquez ou enregistrez des styles personnalisés.

Voir Styles rapides et thèmes.

Propriétés

Définissez les propriétés d’un outil afin de le personnaliser.

Voir Outils d’édition.

Panneau des effets

Cliquez sur le bouton Effets pour afficher les effets d’image disponibles.

Voir Ajout d’effets.

Panneau des captures récentes
Ce panneau affiche les captures d’image et vidéo récentes, ainsi que d’autres fichiers ouverts ou modifiés

dans Snagit Editor. La miniature sélectionnée dans le panneau s’affiche sur le canevas de Snagit Editor.
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Pour afficher d’autres captures récentes, cliquez sur le bouton Bibliothèque dans la partie supérieure de

Snagit Editor.

Conseils concernant le panneau des captures (Windows)

l Pour changer la taille des miniatures dans le panneau, cliquez avec le bouton droit de la souris sur un
élément du panneau, puis sélectionnez Taille de vignette > Petite, Moyenne ou Grande.

l Pour visualiser les métadonnées d’une capture, cliquez avec le bouton droit de la souris sur un élément
du panneau, puis sélectionnez Détails.

Enregistrement d’une capture
Snagit enregistre automatiquement toutes les captures non enregistrées en tant que fichiers SNAGou

SNAGPROJ. Un soleil orange apparaît sur la miniature en cas demodifications non enregistrées. Pour

enregistrer lesmodifications, sélectionnez Fichier > Enregistrer ou Enregistrer sous.

Le format de fichier s’affiche au bas de la miniature.

Pour en savoir plus sur la fonction d’enregistrement automatique de Snagit, cliquez ici.

Retrait d’une capture du panneau des captures
Snagit enregistre automatiquement l’historique des captures dans la bibliothèque, y compris les fichiers

ouverts ou modifiés dans Snagit Editor. Cliquez sur l’icône de fermeture d’uneminiature pour retirer celle-ci

du panneau des captures.
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Le retrait d’un élément du panneau des captures ne supprime pas le fichier correspondant. Cliquez sur le

bouton Bibliothèque pour rechercher et ouvrir cet élément.

Suppression d’une capture
Pour supprimer un fichier définitivement, cliquez avec le bouton droit de la souris sur la miniature dans le

panneau des captures ou dans la bibliothèque, puis sélectionnez Supprimer.
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Redimensionnement du canevas
Le canevas correspond à la zone dans Snagit Editor où les images sont affichées et modifiées.

Zoom avant ou arrière
Utilisez les commandes de zoompour prévisualiser une image.

Le niveau de zoomnemodifie pas la taille finale de l’image. Il ne s’applique qu’à l’aperçu de l’image

dans Snagit Editor et à la taille de la miniature dans la bibliothèque.

Modification du pourcentage de zoom

1. Cliquez sur le bouton Afficher les options de zoom au-dessus du panneau des captures récentes.

2. Faites glisser le curseur Zoomou entrez un pourcentage dans le champ correspondant.

3. Pour définir la taille de l’aperçu sur la taille réelle de l’image, cliquez sur le bouton Taille réelle.

Définition des préférences de zoom
Les options suivantes commandent l’affichage de la capture sur le canevas.
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Exemple Option d’affichage

Ajuster à l’écran

L’affichage de la capture sélectionnée s’ajuste au canevas. Cette option

définit le niveau de zoom en fonction de la taille de la fenêtre de Snagit

Editor.

Taille réelle

L’affichage de la capture sélectionnée correspond aux dimensions réelles

de l’image. Cette option définit le niveau de zoom sur 100 %.

Toujours réduire pour ajuster

En modifiant le niveau de zoom, vous ajustez la capture dans son intégralité

au canevas. Cette opération s’applique à toutes les captures ouvertes.

Affichage de la grille de pixels (Windows)
L’option Grille de pixels affiche les lignes de la grille de pixels pour les images prévisualisées à 600 % ou plus.
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1. Dans Snagit Editor, sélectionnezAffichage >Grille de pixels.

2. Cliquez sur le bouton Afficher les options de zoom au-dessus du panneau des captures récentes.

3. Entrez une valeur de 600 % ou plus dans le champ.

Les lignes de la grille de pixels s’affichent sur le canevas.

Redimensionnement d’une image
Modifiez la taille d’une image en définissant des dimensions spécifiques en pixels, pouces, centimètres, ou en

entrant un pourcentage.

Vous devez aplatir tous les objets vectoriels du canevas pour redimensionner l’image.

1. Pour ouvrir les options de redimensionnement, effectuez l’une des opérations suivantes :

l Dans Snagit Editor, sélectionnez Image > Redimensionner l’image.

l Cliquez sur la liste déroulante Redimensionner l’image au-dessus du panneau des captures
récentes.

2. Sélectionnez une unité.

3. Entrez une largeur et une hauteur. Si vous souhaitez entrer des dimensions de sorte à obtenir des
proportions autres que celles de l’image actuelle, cliquez sur l’icôneGarder les proportions.

4. SousWindows, cliquez sur l’optionOptions avancéespour afficher des options supplémentaires.

l Résolution : définit la densité des pixels d’une image. La résolution est mesurée en points par pouce
(dpi).

l Utiliser le rééchantillonnage :modifie le nombre de pixels d’une image. Le suréchantillonnage
ajoute des pixels à une image. Le sous-échantillonnage supprime les pixels non nécessaires et peut
réduire la taille d’un fichier.

Il est recommandé d’utiliser les autres options de redimensionnement avant d’activer cette

option. Cette option peut détériorer progressivement la qualité de l’image.

5. Cliquez sur le bouton Appliquer (Windows) ou Redimensionner (Mac).
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Styles rapides et thèmes
l Définissez un style rapide pour vous souvenir automatiquement d’un style d’outil personnalisé lors
d’utilisations ultérieures.

l Pour créer un ensemble de styles rapides appliqués à différents outils, en se basant sur une palette de
couleurs présélectionnées, voir Création d’un thème.

Les outils sont uniquement disponibles avec les captures d’image. Partagez votre vidéo vers

Camtasia pour l’améliorer avec des annotations et des effets.

Application d’un style rapide
1. Dans Snagit Editor, cliquez pour sélectionner un outil.
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2. Les propriétés de l’outil s’ouvrent. Cliquez pour sélectionner un style rapide.

3. La méthode d’utilisation du style rapide sur le canevas dépend de l’outil sélectionné. Suivez les
instructions en surbrillance pour utiliser les outils.

Enregistrement d’un style rapide
Après avoirmodifié les propriétés d’un outil, vous pouvez enregistrer ces propriétés personnalisées en tant

que style rapide afin de les réutiliser plus tard.

Pour enregistrer ce style dans un thème spécifique, choisissez un thème dans lemenu situé au
sommet du panneau Styles rapides avant de sélectionner l’outil.

1. Dans Snagit Editor, cliquez pour sélectionner un outil.

2. Les propriétés de l’outil s’ouvrent. Modifiez les propriétés voulues.
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3. Àmesure que vousmodifiez les propriétés de l’outil, un nouveau style rapide apparaît au bas du
panneau des styles existants.

4. Cliquez sur l’icône  pour enregistrer ce nouveau style rapide.

5. Pour le changer d’emplacement dans le panneau Styles rapides, cliquez dessus et faites-le glisser vers
un nouvel emplacement.

Conseil : enregistrez les styles rapides que vous utilisez souvent dans l’outil Favoris.

Cliquez sur l’icône  du style pour l’ajouter aux favoris. L’icône s’affiche en jaune lorsque le

style rapide est enregistré dans les favoris.

Pour supprimer un style rapide, cliquez dessus avec le bouton droit de la souris et sélectionnez
Supprimer le style rapide (Windows et Mac). Le style rapide est définitivement supprimé du thème
sélectionné.

Création d’un thème
Les thèmes se composent de styles rapides propres à chaque projet, organisation ou guide de style que vous

utilisez. Snagit vous aide à définir un thème en fonction de la palette de couleurs sélectionnée. Vous avez la

possibilité d’ajouter des styles supplémentaires ou demodifier le thème à tout moment.

1. Dans Snagit Editor, cliquez pour sélectionner un outil.
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2. Les propriétés de l’outil s’ouvrent.

l Windows : cliquez sur la liste déroulante Thème et sélectionnez l’optionNouveau thème.

l Mac : cliquez sur l’icône  et sélectionnez l’optionNouveau thème.

3. La boîte de dialogueNouveau thème s’affiche. Cliquez sur la liste déroulanteCouleurspour
sélectionner une couleur et générer automatiquement des styles rapides pour ce thème.

l Cliquez pour sélectionner une couleur parmi les couleurs prédéfinies ou parmi celles de la palette
de couleurs.

l Cliquez sur l’outil Pipette, puis cliquez où vous le souhaitez dans l’écran pour sélectionner une
couleur.

l Entrez une valeur HEX ou RVB dans le champ.

Pour ajouter la couleur à la paletteMes couleurs du thème, cliquez sur le bouton d’ajout.

4. Appuyez sur la touche Échap pour quitter la sélection de couleur.

5. Pour ajouter d’autres couleurs, cliquez sur le bouton d’ajout. Poursuivez l’opération jusqu’à ce que vous
ayez obtenu le nombre de couleurs voulu pour le thème.
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Conseil sur les couleurs d’un thème

Il est recommandé de sélectionner un 4 à 8 couleurs pour générer un nouveau thème.

6. Entrez un nomévocateur dans le champ Nomdu thème.

7. Cliquez sur le bouton Créer.

Snagit génère automatiquement un ensemble de styles rapides en fonction des couleurs sélectionnées. Ce

nouveau thème est disponible dans la plupart des outils.

Modification d’un thème
1. Dans Snagit Editor, cliquez pour sélectionner un outil.

2. Les propriétés de l’outil s’ouvrent.

l Windows : dans la liste déroulante Thème, cliquez sur l’icône  à côté du thème et sélectionnez
Modifier.
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l Mac : cliquez sur l’icône  et sélectionnezModifier.

3. La boîte de dialogueModifier le thème s’affiche. Effectuez lesmodifications voulues.

4. Cliquez sur Enregistrer.

IMPORTANT :

La modification d’un thème écrase les styles rapides existants de ce thème. Pour les conserver,

vous avez la possibilité demodifier ces styles séparément. Voir Enregistrement d’un style rapide.

Exportation d’un thème
Exportez un thème afin d’améliorer la collaboration sur un projet ou de conserver un guide de style

d’entreprise ou unemarque.

1. Dans Snagit Editor, cliquez pour sélectionner un outil.
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2. Les propriétés de l’outil sélectionné s’affichent dans le panneau des propriétés situé dans la partie droite
de Snagit Editor.

l Windows : dans la liste déroulante Thème, cliquez sur l’icône  à côté du thème et sélectionnez
Exporter.

l Mac : cliquez sur l’icône  et sélectionnez Exporter le thème.

3. Choisissez l’emplacement d’exportation et entrez un nomde fichier. Cliquez sur Enregistrer.

Snagit enregistre le thème en tant que fichier .snagtheme. Vous avez la possibilité d’envoyer le fichier à

d’autres collaborateurs qui pourront l’importer dans Snagit.

Vous devez disposer de Snagit Windows version 13.1 ou supérieure ou de Snagit Mac version 4.1 ou

supérieure pour importer un thème.

Importation d’un thème
1. Dans Snagit Editor, cliquez pour sélectionner un outil.

2. Les propriétés de l’outil sélectionné s’affichent dans le panneau des propriétés situé dans la partie droite
de Snagit Editor.
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l Windows : cliquez sur la liste déroulante Thème et sélectionnez Importer.

l Mac : cliquez sur l’icône  et sélectionnez Importer.

3. Recherchez et sélectionnez le fichier .snagtheme et cliquez surOuvrir.

Snagit ajoute le thème à la liste des thèmes disponibles.
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Outils d’édition
La barre d’outils de Snagit Editor se compose d’outils d’édition permettant d’annoter, demodifier et

d’améliorer les captures d’image.

l Déplacez, redimensionnezou supprimez des objetsmultiples d’une image.

l Attirez l’attention à l’aide de flèches, textes, formes, surlignages et de légendes.

l Reconnaissez et modifiez le texte d’une image.

l Effectuez des sélections précises sur le canevas avec les outils Sélection et Baguettemagique. Le
remplissage auto peut être désactivé et activé, et permet de remplir les zones supprimées.

l Créez des images d’infographie, des topogrammes et des images de diapositives de présentation à l’aide
de formes et de lignes.

l Dissimulez les informations sensibles avec un effet de flou ou recouvrez-les avec une forme.

l Ajoutez des timbres, par exemple, des pointeurs, des images d’appareil statique, desmarques de
relecture ou des annotations amusantes.

l Ajoutez une séquence de chiffres ou de lettres pour désigner les différentes étapes d’une capture.

l Supprimez des zones à l’aide des outils Rogner ou Découper pour nemontrer que le contenu important
de l’image.

Les outils d’annotation sont uniquement disponibles avec les captures d’image. Partagez votre

vidéo versCamtasia pour l’améliorer avec des annotations et des effets.

Types d’outils

l Flèche

l Flou

l Légende

l Rogner

l Découper

l Gomme

l Favoris

l Remplir

l Saisie de texte

l Baguettemagique

l Loupe

l Déplacement

l Stylo

l Sélection

l Forme

l Simplifier

l Timbre

l Étape
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l Surligneur

l Ligne
l Texte

Flèche

Ajoutez une flèche pour attirer l’attention sur un élément de l’image ou lemettre en avant.

l Cliquez sur l’outil et faites-le glisser sur le canevas pour dessiner une flèche.

l Pour obtenir une flèche courbe : 

l Windows : dans les propriétés, activez l’option Courbe de Bézier. Cliquez sur un point
de la flèche et faites-le glisser pour commencer la courbe. Àmesure que vous modifiez
la courbe, une poignée blanche apparaît sur le canevas. Faites glisser la poignée pour
continuer à modifier la sélection.

l Mac : cliquez sur la poignée jaune et faites-la glisser pour rendre la flèche courbe.

Flou

Ajoutez un effet de flou pour dissimuler ou masquer les informations sensibles que contient une
image.

l Sous Windows, deux types sont disponibles :

l Lisse : réduit les détails dans une capture, pour l’obtention d’un effet similaire à une
visualisation via une lentille défocalisée. Utilisez ce type pour ajouter une profondeur ou
pour estomper les détails d’informations sensibles.

l Pixelisé : recouvre une zone avec de grands pixels carrés. Utilisez ce type pour
masquer des visages ou des informations sensibles sur une capture d’image.

1. Faites glisser le curseur pour régler l’intensité du flou (Windows etMac).

2. Cliquez sur l’outil et faites-le glisser sur le canevas pour dessiner le flou.

Légende

Ajoutez une légende pour attirer l’attention sur un élément de l’image ou lemettre en avant. Une

légende comprend une annotation et un texte.

1. Cliquez sur la liste déroulanteContour ou Remplir, puis effectuez l’une des opérations
suivantes :

l Cliquez pour sélectionner une couleur parmi les couleurs prédéfinies ou parmi celles de
la palette de couleurs.

l Cliquez sur l’outil Pipette, puis cliquez où vous le souhaitez dans l’écran pour
sélectionner une couleur.
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l Entrez une valeur HEX ou RVB dans le champ.

2. Cliquez et faites glisser la souris sur le canevas pour sélectionner la zone à supprimer.

3. Entrez le texte de la légende.

4. Utilisez les poignées pour effectuer les opérations suivantes :

l Pour redimensionner la légende, faites glisser les poignées blanches.

l Pour redimensionner le pointeur, faites glisser la poignée jaune. (Windows)

l Pour ajouter un pointeur de légende supplémentaire, faites glisser la poignée bleue.
(Mac)

l Pour faire pivoter la légende, faites glisser la poignée verte.

Pour déplacer le corps de la légende autour du pointeur, faites glisser le point d’ancrage.

Rogner

Supprimez les zones inutiles des bords d’une image.

1. Une grille avec des poignées bleues indique la zone de l’image sélectionnée pour le rognage.
Pour rogner d’autres côtés de l’image, faites glisser les poignées bleues correspondantes.

2. Cliquez sur le bouton Rogner pour enregistrer les modifications.
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Découper

Supprimez une section verticale ou horizontale d’une image et joignez les deux parties.

1. Sélectionnez un style horizontal ou vertical. Une ligne apparaît sur le canevas.

2. Cliquez et faites glisser la souris sur le canevas pour sélectionner la zone à supprimer.

Gomme

Gommez toute zone aplatie d’une image pour faire apparaître le canevas.

Favoris

Pour accéder plus vite aux styles rapides que vous utilisez souvent, enregistrez-les dans les favoris.

l Pour enregistrer un style rapide dans les favoris, cliquez sur l’icône du style.

l Pour retirer un style rapide des favoris, cliquez sur l’icône du style.

L’icône s’affiche en jaune lorsque le style rapide est enregistré dans les favoris.
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Remplir

Remplissez avec une autre couleur l’intégralité d’une zone aplatie sur une image.

1. Cliquez sur la liste déroulante Remplir, puis effectuez l’une des opérations suivantes :

l Cliquez pour sélectionner une couleur parmi les couleurs prédéfinies ou parmi celles de
la palette de couleurs.

l Cliquez sur l’outil Pipette, puis cliquez où vous le souhaitez dans l’écran pour
sélectionner une couleur.

l Entrez une valeur HEX ou RVB dans le champ.

2. Cliquez pour appliquer la couleur de remplissage à un emplacement du canevas.

Saisie de

texte Capturez du texte sur l’écran et collez-le dans un autre programme.

Voir Saisie de texte.

Surligneur

Surlignez une zone rectangulaire dans une image.

Ligne

Ajoutez une ligne droite ou courbe à une image.

Baguette

magique Sélectionnez une zone du canevas en fonction de sa couleur. Cet outil s’avère idéal pour
sélectionner des zones d’une seule couleur sans motifs ni arrière-plan complexes.

Loupe

Effectuez un zoom sur une zone du canevas pour la mettre en relief ou en afficher les détails.

Déplacement Sélectionnez un objet à déplacer au sein du canevas. Activez Smart Move pour pouvoir sélectionner
instantanément plusieurs objets sur l’écran. Cet outil permet aussi d’identifier les textes pouvant être
repositionnés ou supprimés. Voir Smart Move.

Stylo

Dessinez des lignes à main levée sur une image.
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Sélection

Sélectionnez des parties d’une image. Après avoir sélectionné une zone du canevas, vous pouvez

couper, copier, déplacer, supprimer, modifier cette sélection ou lui appliquer des effets.

Cliquez sur l’outil Sélection pour afficher les propriétés de l’outil dans la partie droite de Snagit

Editor. Avant de sélectionner une zone du canevas, définissez les propriétés suivantes :

l Forme

l Aligner sur l’objet

l Remplissage de l’arrière-plan

l Qualité d’optimisation (Windows)

Forme Ajoutez une forme ou une image statique à une image. Vous avez la possibilité de choisir la forme, le
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contour et la couleur de remplissage.

l Pour redimensionner la forme, faites glisser les poignées blanches.

l Pour faire pivoter la forme, faites glisser la poignée verte.

Pour un polygone :

1. Cliquez et faites glisser la souris sur le canevas pour dessiner le premier côté de la forme.

2. Cliquez pour ancrer chaque coin de la forme.

3. Double-cliquez (Windows) ou appuyez sur Entrée (Mac) pour finaliser la forme.

Simplifier
Remplacez le texte et autres éléments visuels d’une image par des objets simplifiés pour attirer

l’attention sur ce qui est important dans l’image.

Voir Outil Simplifier.

Timbre

Annotez une image avec les timbres par défaut de Snagit, téléchargez-en d’autres depuis le siteWeb

de TechSmith ou créez vos propres timbres (Windows uniquement).

Ajout d’un timbre

1. Dans Styles rapides, sélectionnez un timbre.

2. Cliquez sur le canevas pour ajouter le timbre.

l Pour déplacer le timbre, cliquez sur celui-ci et faites-le glisser vers l’emplacement voulu.

l Pour redimensionner le timbre, cliquez sur une poignée blanche et faites-la glisser.

Téléchargement de timbres

1. Dans le panneau des propriétés, cliquez sur le bouton Télécharger plus.
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2. Le siteWeb de TechSmith s’ouvre. Localisez le jeu de timbres voulu et cliquez sur le lien
Download (Télécharger).

Création d’un timbre personnalisé

Enregistrez des images, des annotations ou des objets du canevas sous forme de timbres

personnalisés.

1. Sous Windows, sélectionnez l’outil Timbre > bouton Organiser les timbres > Ajouter un
timbre. Sur Mac, sélectionnez l’outil Timbre > Importer des timbres.

2. Recherchez et sélectionnez une image, puis cliquez surOuvrir.

Conseil de pro : ajoutez des termes de recherche afin de trouver rapidement vos timbres

(Mac uniquement).

Dans les Styles rapides, appuyez sur la touche Ctrl et cliquez sur un timbre, puis

sélectionnezModifier les termes de la recherche. Saisissez un terme de recherche.

Séparez les termes de recherche par une virgule.

Étape

Ajoutez une séquence de chiffres ou de lettres sur une image

Texte
Ajoutez des sous-titres, des titres ou d’autres textes à une image.

Sélectionnez les couleurs de contour et de remplissage du texte. Vous avez aussi la possibilité de

choisir l’alignement, la taille et la police du texte. Pour modifier un texte, double-cliquez sur la zone

de texte correspondante et entrez le texte voulu. Voir Saisie de texte.
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Utilisation des propriétés d’outil
Personnalisez les propriétés d’outil dans le panneau des propriétés.

1. Cliquez pour sélectionner un outil dans la barre d’outils de Snagit Editor.
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2. Les propriétés de l’outil sélectionné s’affichent dans le panneau des propriétés situé dans la partie droite
de Snagit Editor.

3. Pour sélectionner les propriétés de l’outil, effectuez l’une des opérations suivantes :

l Cliquez pour sélectionner un style dans Styles rapides. La liste Styles rapides contient des
présélections ou des styles personnalisés.

l Modifiez les paramètres de l’outil sélectionné dans le panneau des propriétés.

4. La méthode d’utilisation du style rapide sur le canevas dépend de l’outil sélectionné. Les propriétés
disponibles varient en fonction de l’outil sélectionné.

Types de propriétés

Couleur
l Remplir : modifiez la couleur à l’intérieur d’une forme ou d’un texte.

l Contour : modifiez la couleur du contour d’une forme ou d’un texte.

Pipette
Sélectionnez une couleur quelconque sur l’écran. Cliquez sur l’outil Pipette, puis cliquez où vous

le souhaitez sur l’écran pour sélectionner une couleur.
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Ombre
Cliquez pour sélectionner une direction d’ombre. Pour désactiver l’ombre, désélectionnez la
direction d’ombre.

Police
Modifiez le nom de la police, la couleur de la police, et la taille de la police à l’aide du curseur ou
via saisie manuelle.

Opacité Faites glisser le curseur pour régler la transparence des couleurs de l’outil.

Courbe de
Bézier

Courbez votre flèche/ligne au niveau d’un ou de plusieurs points. Activez/désactivez puis faites
glisser les poignées qui s’affichent autour de la flèche ou de la ligne pour ajuster la courbe vers le
haut ou le bas.

Épaisseur Faites glisser le curseur pour régler la largeur en pixels d’une ligne ou d’un contour.

Tolérance
Faites glisser le curseur pour déterminer la proximité par rapport à un objet à laquelle le

programme réalise les modifications sur une image.

Détail Faites glisser le curseur pour régler le seuil auquel le programme identifie les objets du canevas.

Remplissage
de l’arrière-
plan

l Transparent : remplissez les zones supprimées avec de la transparence (canevas vide).

l Remplissage auto : remplissez automatiquement la sélection en fonction du contenu
environnant.

Intensité Faites glisser le curseur pour déterminer la quantité de flou à appliquer à la sélection.

Sélection

Moins/Plus
Faites glisser le curseur pour régler la plage de couleurs comprises dans la sélection.

Anticrénelage Cochez la case pour obtenir un rendu lisse des lignes et des bords.

Créer
comme
vecteur

Cochez la case pour permettre la mise à l’échelle d’un objet sans perte de qualité.

Personnalisation de la barre d’outils Snagit Editor
Personnalisez la barre d’outil d’édition pour accéder rapidement à vos outils, destinations de partage et effets

favoris. Vous avez la possibilité d’ajouter, de supprimer ou de réorganiser les options de la barre d’outils.

1. Dans la barre d’outils de Snagit Editor, cliquez sur le bouton Plus et sélectionnezPersonnaliser la barre
d’outils.
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2. La boîte de dialogue de personnalisation de la barre d’outils s’affiche.

l Pour ajouter une option à la barre d’outils, faites glisser cette option depuis la boîte de dialogue
vers l’emplacement voulu de la barre d’outils.

l Pour supprimer une option de la barre d’outils, faites-la glisser hors de celle-ci.

l Pour réorganiser des options de la barre d’outils, faites glisser ces options vers les emplacements
voulus de la barre d’outils.

3. Après avoir personnalisé la barre d’outils, cliquez sur Terminer.

4. Dans la barre d’outils, vous pouvez choisir d’afficher les icônes seules ou les icônes et les étiquettes de
texte. Pour changer cette option, cliquez avec le bouton droit de la souris sur la barre d’outils et
sélectionnez Icône et texte ou Icône uniquement.
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Ajout d’effets
Ajoutez un effet à une image pour la mettre en valeur. Les effets peuvent être à une partie de l’image ou à

l’image toute entière.

Ils sont uniquement disponibles avec les captures d’image. Partagez votre vidéo versCamtasia pour

l’améliorer avec des annotations et des effets.

Ajout d’un effet d’image
1. Cliquez sur le bouton Effets.

2. Le panneau des effets s’ouvre. Effectuez l’une des opérations suivantes pour appliquer un effet :

l Sélectionnez un style dans le panneau Effets rapides.

l Windows : cliquez pour sélectionner un effet. Sélectionnez les paramètres dans la liste déroulante
et cliquez sur Appliquer.
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l Mac : cliquez pour sélectionner un effet. Cliquez sur le bouton pour personnaliser les
paramètres.

CONSEIL : enregistrez un effet personnalisé en tant qu’effet rapide.

l Windows : cliquez sur le bouton Ajouter aux effets rapides.

l Mac : lorsque vousmodifiez les propriétés d’un effet, le nouvel effet apparaît au bas du panneau Effets

rapides. Cliquez sur l’icône pour enregistrer cet effet en vue d’une utilisation ultérieure.

Suppression d’un effet d’une image
l Windows : sélectionnez Édition > Annuler pour supprimer le dernier effet appliqué. Si vous avez besoin
de supprimer plusieursmodifications, sélectionnezAnnuler à plusieurs reprises.

l Mac : dans le panneau des effets, cliquez sur un effet en bleu pour le désactiver. Pour désactiver tous les
effets, cliquez sur l’effet rapide Sans effet.

Application d’un effet rapide
Les styles rapidesmémorisent automatiquement les paramètres de vos effets personnalisés pour les réutiliser

ultérieurement.

1. Cliquez sur le bouton Effets.

Aide de Snagit | 72

https://www.techsmith.com/


2. Le panneau des effets s’ouvre. Passez la souris sur un effet rapide.

3. Un aperçu de l’effet rapide s’affiche sur le canevas (Windows). Cliquez dessus pour appliquer cet effet
rapide.

Types d’effet de Snagit

l Bordure

l Bords

l Enroulement de page (Windows)

l Ombre

l Perspective

l Réflexion (Mac)

l Filtres (Windows)

l Filtres couleur (Mac)

l Ajustement des couleurs (Windows)

l Remplacement de couleurs (Windows)

l Projecteur et loupe (Windows)

l Filigrane (Windows)

l Fondu (Mac)

Bordure

Ajoutez une bordure à l’extérieur d’une image.

Bords

Ajoutez un effet de bord à un ou plusieurs côtés d’une image.

Aide de Snagit | 73

https://www.techsmith.com/


Enroulement de

page (Windows)

Ajoutez un effet d’enroulement au coin d’une image.

Ombre

Ajoutez un effet ombré sur un côté de l’image ou tout autour.

Perspective

Déformez l’image pour donner l’impression qu’elle est visualisée sous un angle différent.

Réflexion (Mac)

Ajoutez une réflexion de l’image comme s’il y avait un miroir.

Filtres (Windows)

Appliquez un effet de filtre à la totalité de l’image. Vous pouvez choisir l’un des types de filtre

suivants dans lemenu déroulant avant d’appliquer cet effet :

l Atténuer

l Améliorer la netteté

l Opacité
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l Monochrome

l Niveaux de gris

l Inverser les couleurs

Filtres couleur

(Mac)

Appliquez un effet de filtre à la totalité de l’image. Vous pouvez modifier les propriétés

suivantes pour cet effet :

l Niveaux de gris

l Sépia

l Inverser

Ajustement des

couleurs

(Windows)

Améliorez ou corrigez la couleur et la tonalité (luminosité, ombres et contraste) d’une image.

Vous pouvez modifier les propriétés suivantes pour cet effet :

l Luminosité

l Contraste

l Teinte

l Saturation

l Gamma

Remplacement de

couleurs

(Windows)

Inversez deux couleurs dans une image ou remplacez une couleur par une autre. Vous
pouvez sélectionner plusieurs groupes de couleurs à inverser en cliquant sur

 avant d’appliquer cet effet.

Projecteur et loupe

(Windows)

Attirez l’attention sur une zone d’une image en la mettant en surbrillance et en la grossissant.

Après avoir sélectionné une zone sur votre image à l’aide de l’outil Sélection, sélectionnez

Projecteur et loupe dans le panneau Effets rapides.

Filigrane

(Windows)

Ajoutez un texte, un logo ou des informations de copyright à une image à des fins
d’identification ou pour prévenir toute utilisation non autorisée.
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Fondu (Mac)

Estompez progressivement les bords d’une image.
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Montage de vidéos
Une fois que vous avez enregistré une capture vidéo, le fichierMP4 s’ouvre dans Snagit Editor, ou vous

pouvez la visualiser et la monter.

Les commandes de lecture s’affichent sous la vidéo.

Commande vidéo Description

Temps écoulé
Affiche le temps écoulé à la position de la tête de lecture sur le plan de
montage chronologique.

Poignée de début
Faites glisser la poignée pour sélectionner le point de départ de la
sélection vidéo.

Tête de lecture
Commande l’image vidéo affichée. Faites glisser la tête de lecture pour
passer à un point spécifique de la vidéo.

Poignée de fin
Faites glisser la poignée pour sélectionner le point de fin de la sélection

vidéo.

Image précédente
Cliquez sur ce bouton pour reculer d’une image.

Cliquez etmaintenez ce bouton enfoncé pour rembobiner.

Lecture/Pause Permet de lire la vidéo ou de la mettre sur pause.

Aide de Snagit | 77

https://www.techsmith.com/


Commande vidéo Description

Image suivante
Cliquez sur ce bouton pour passer à l’image suivante.

Cliquez etmaintenez ce bouton enfoncé pour avancer rapidement.

Création d’un GIF animé
Enregistrez la sélection actuelle de la vidéo ou la vidéo toute entière sous

forme de fichier GIF animé.

Enregistrement d’une
image au format PNG

Enregistrez une image vidéo sous forme d’image fixe. La nouvelle image
s’ouvre dans le panneau des captures.

Durée Affiche la durée totale de la vidéo.

Suppression de sections non voulues d’une vidéo
Coupez les parties non voulues d’une vidéo, par exemple si vous vous reprenezou vous râclez la gorge en

cours d’enregistrement, ou supprimez le début et la fin de la vidéo.

1. Dans le plan demontage chronologique, faites glisser la poignée de début jusqu’à l’emplacement
marquant le début de la coupure

2. Dans le plan demontage chronologique, faites glisser la poignée de fin jusqu’à l’emplacement
marquant la fin de la coupure.
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3. Pour prévisualiser la coupure, faites glisser la tête de lecture jusqu’à l’emplacement qui doit marquer le
début de la lecture de la vidéo. Cliquez sur le bouton Lecture.

4. Cliquez sur le bouton Couper.

Le segment vidéo coupé est représenté par une ligne jaune dans dans le plan demontage chronologique.

Enregistrement d’une image vidéo sous forme de
fichier image
Capturez l’image vidéo actuelle sous forme d’image fixe.

1. Ouvrez une capture vidéo ou cliquez pour sélectionner une vidéo dans le panneau des captures
récentes.

2. Faites glisser la tête de lecture jusqu’à l’image vidéo voulue.

3. Cliquez sur le bouton Enregistrer l’image au format PNG.

La nouvelle image s’ouvre dans le panneau des captures.

CONSEIL : vous avez besoin d’options demontage vidéo supplémentaires ?

Pour obtenir des options demontage supplémentaires, partagez la vidéo vers TechSmith Camtasia.
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Création de GIF animés
Snagit vous permet de créer des imagesGIF à partir d’une sélection d’une vidéo ou d’une vidéo entière.

Création d’un GIF
1. Ouvrez une capture vidéo ou cliquez pour sélectionner une vidéo dans le panneau des captures

récentes.

2. Faites glisser les poignées de début et de fin pour sélectionner une partie de la vidéo qui servira à créer le

GIF animé.

CONSEIL : le passage ne doit pas être trop long.

Il est recommandé de sélectionner un segment demoins de 30 secondes.

3. Faites glisser la tête de lecture vers la poignée verte et cliquez sur le bouton Lecture pour afficher un
aperçu de la sélection.

4. Si vous êtes satisfait de la sélection, cliquez sur le bouton Créer un GIF animé.

5. Indiquez si vous utilisez la sélection que vous venez de choisir ou l’intégralité de la vidéo pour créer le
GIF.

6. La boîte de dialogue de création d’un GIF s’affiche. Sélectionnez une option dans la listeOptimiser
pour :

l Vidéo d’écran (par défaut) : sélectionnez cette option si la vidéo contient un enregistrement
d’écran.

l Vidéo High Motion : sélectionnez cette option si la vidéo contient une vidéo ou des jeux réels.

l Taille de fichier réduite : sélectionnez cette option pour optimiser la taille du fichier. Snagit réduit
les dimensions de la vidéo de façon à obtenir une largeur ou une hauteur de 200 pixelsmaxi.

l Personnalisé : sélectionnez cette option pour personnaliser les paramètres. Voir Paramètres de GIF
personnalisés.
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7. Cliquez sur le bouton Créer.

Snagit crée le fichier GIF animé et l’ajoute au début du panneau des captures récentes.

Paramètres de GIF personnalisés

Paramètre Description

Fréquence
d’images

Nombre d’images par seconde. Une fréquence d’images élevée permet une lecture de la vidéo plus
fluide, mais risque d’augmenter la taille du fichier.

Dimensions
(unité)

Sélectionnez l’unité d’affichage de la largeur et de la hauteur.

Dimensions
(Largeur et
Hauteur)

Entrez la largeur et la hauteur du fichier GIF animé. Diminuez ces dimensions pour réduire la taille du
fichier GIF animé.

Garder les
proportions

Il est recommandé de garder les proportions (le rapport hauteur/largeur de la vidéo). Dans le cas

contraire, la vidéo risque de présenter des distorsions ou d’être floue.

Activer le
faux
dégradé

Activez le faux dégradé pour éviter des bandes de couleur et améliorer la qualité de la vidéo. Cette

option peut augmenter la taille de fichier.

Boucle
l Si cette option est désactivée, la lecture du GIF animé s’effectue en boucle continue.

l Si cette option est désactivée, la lecture du GIF animé s’effectue jusqu’à la fin de la vidéo.

Couleurs
dynamiques
(Mac)

Cette option est recommandée pour la plupart des vidéos. Cette option peut augmenter la taille de

fichier. Si vous avez besoin de réduire la taille de fichier, désactivez cette option pour les vidéos

présentant de faibles variations de couleur.

Fondu
jusqu’au
noir

Ajoutez une transition à fin du GIF animé pour fondre la dernière image jusqu’au noir.
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Importation de captures depuis un appareil
mobile
TechSmith Fuse est une application pour appareilsmobiles qui vous permet d’envoyer des images et des

vidéos depuis votre appareil mobile directement vers Snagit. Vous avez ainsi la possibilité d’effectuer des

captures, de collaborer avec vos collègues et d’accéder à votre contenu, où que vous soyez.

Fuse est disponible depuisGoogle Play Store ou App Store. Cette application est prise en charge sur les

appareilsmobiles exécutant les systèmes d’exploitation suivants :

l iOS version 9 et ultérieures (téléphones et tablettes) ;

l Android version 4.0 et ultérieures.

Importation à l’aide de TechSmith Fuse
1. Installez TechSmith Fuse depuisGoogle Play Store ou App Store sur votre appareil mobile.

2. Dans Snagit Editor, sélectionnez Fichier > Connecter un appareil mobile. La boîte de dialogue
Connecter un appareil mobile s’ouvre.

3. Connectez votre ordinateur et votre appareil mobile au même réseau.

4. Ouvrez TechSmith Fuse sur votre appareil mobile.

5. Sélectionnez l’élément multimédia à envoyer :

l Appuyez sur Library pour une importation depuis votre appareil ou pour sélectionner un élément
multimédia existant.

l Appuyez sur Video pour enregistrer une vidéo.

l Appuyez sur Photo pour prendre une photo.
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6. Appuyez sur Share et sélectionnez Snagit.
Si l’icône Snagit ne s’affiche pas, appuyez surMore.

7. Appuyez surConnect to Snagit.
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8. Le scanner apparaît. Pointez votre caméra vers le codeQR de la boîte de dialogue Connecter un
appareil mobile. Voir Conseils pour lire le codeQR.

L’image ou la vidéo est envoyée au panneau de Snagit Editor.

Conseils pour lire le code QR
Suivez ces conseils pour lire le codeQR à l’aide de TechSmith Fuse sur votre appareil mobile :

l Vérifiez que l’appareil est allumé et connecté au même réseau que l’ordinateur exécutant Snagit.

l Pointez la caméra de l’appareil vers le codeQR à l’écran de l’ordinateur.

l Positionnez la caméra de sorte que le codeQR soit centré par rapport aux coins de l’écran du scanner
dans TechSmith Fuse sur votre appareil mobile ou tablette.

À propos de la connexion entre TechSmith Fuse et Snagit

l L’ouverture de la boîte de dialogue Connecter un appareil mobile active l’option de partage mobile.

l Vous devez lire le codeQR dans Snagit pour établir une connexion entre l’appareil mobile et Snagit en
vue d’envoyer des fichiers de l’appareil mobile.

l Votre appareil mobile et l’ordinateur exécutant Snagit doivent être connectés au même réseau.

l Snagit doit être ouvert sur l’ordinateur.
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À propos du partage mobile à l’aide de TechSmith Fuse
Le partagemobile permet à Snagit de recevoir des fichiers de TechSmith Fuse. Il est désactivé par défaut et

n’est activé que lorsque vous :

l connectez TechSmith Fuse à Snagit depuis votre appareil mobile ;

l sélectionnez Snagit Editor > Édition > Préférences Editor > onglet Options avancées>Autoriser le
partage vers Snagit.

Une fois le partagemobile activé, vous pouvez connecter Fuse à Snagit. Le partagemobile est exécuté

jusqu’à ce qu’il soit désactivé.

Snagit ouvre un port sur votre ordinateur pour établir une connexion sécurisée entre votre appareil

mobile et Snagit. Si vous avez des inquiétudes concernant la sécurité du fait que la connexion reste

ouverte après le transfert des fichiers depuis Fuse, vous pouvez désactiver le partagemobile.

Désactivation du partage mobile :
Sélectionnez Snagit Editor > Édition > Préférences Editor > onglet Options avancées, puis cliquez sur Activer le

partage vers Snagit. Le partagemobile peut également être désactivé s’il est interrompu. Ceci peut se

produire dans les cas suivants :

l Votre réseau/routeur est déconnecté ou doit être réinitialisé.

l Votre ordinateur génère automatiquement de nouvelles adresses IP.

l Vous changez de fournisseur Internet.

Dépannage de TechSmith Fuse
Lorsque TechSmith Fuse ne parvient pas à se connecter ou à envoyer de fichiers vers Snagit, reportez-vous

aux sections suivantes :

l Impossible d’envoyer des fichiers de TechSmith Fuse vers Snagit

l Impossible de lire le codeQR

l Absence de codeQR

Impossible d’envoyer des fichiers de TechSmith Fuse vers Snagit
Si vous ne parvenez pas à envoyer de fichiers depuis TechSmith Fuse vers Snagit, vérifiez les éléments

suivants :
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l Vérifiez que Snagit est ouvert sur l’ordinateur lorsque vous envoyez des fichiers depuis TechSmith Fuse.

l Vérifiez que le partage surmobile est activé :

l SousWindows, sélectionnez Snagit Editor > Édition > Préférences Editor > onglet Options
avancées > Autoriser le partage vers Snagit.

l SurMac, sélectionnez Snagit Editor > Snagit > Préférences > onglet Options avancées.

l Vous devez lire le codeQR dans Snagit pour établir une connexion entre l’appareil mobile et Snagit en
vue d’envoyer des fichiers de l’appareil mobile.

l Votre appareil mobile et l’ordinateur exécutant Snagit doivent être connectés au même réseau.

l Réinitialisez le routeur ou le réseau sans fil.

l Vérifiez les paramètres du réseau ou du pare-feu.

Impossible de lire le code QR
Si TechSmith Fuse ne parvient pas à lire le codeQR de la boîte de dialogue Connecter un appareil mobile

(Snagit Editor > Fichier > Connecter un appareil mobile), vérifiez les éléments suivants :

l Assurez-vous que l’appareil est connecté au même réseau Wi-Fi que l’ordinateur exécutant Snagit.

l Pointez la caméra de l’appareil vers le codeQR à l’écran de l’ordinateur.

l Positionnez la caméra de sorte que le codeQR soit centré par rapport aux coins de l’écran du scanner
dans TechSmith Fuse sur votre appareil mobile ou tablette.

Absence de code QR
Lorsqu’un codeQR ne peut pas être généré, un message d’erreur s’affiche dans la boîte de dialogue

Connecter un appareil mobile (Snagit Editor > Fichier > Connecter un appareil mobile) dans Snagit.

Le codeQR ne peut pas être généré lorsque :

l le réseau/routeur est déconnecté ou doit être réinitialisé ;

l le port spécifié est déjà utilisé.

Si le codeQR n’est pas généré :

l Vérifiez les paramètres du réseau ou du pare-feu.

l Connectez votre ordinateur et votre appareil mobile à un autre réseau.
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Snagit Editor Preferences and Shortcuts

Preferences
To open the Snagit Preferences, select Snagit > Preferences.

Preferences allow you to apply custom settings for all image and video captures.

l General

l Capture

l Outputs

l Keyboard

l Advanced

l

Locate information about theCapture and Keyboard tabs under Snagit Capture Preferences

and Shortcuts.

See Share Captures formore information on theOutputstab.

General Preferences

Option Description

Always keep Snagit
running in the
background

Keep Snagit running in the background to start a capture at anytime.

Snagit Shows

Choose the display for the capture options. Capture window is the default display.

l Capture Window: Displays the capture options from a window in themenu bar. The
Capture window provides options for both quick and customized capture.

l OneClick Tab: Displays the quick capture options as a tab on the upper-right side of
the screen. The quick capture options display when you hover the cursor over the
blur bar.

l Capture Window & OneClick Tab: Displays the capture options in themenu bar and
as a tab on the side of the screen.
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Option Description

Editor color theme Choose between the two Snagit interface color themes: Light or Dark

Send anonymous
usage information

Send anonymous data on Snagit usage to help TechSmith improve future versions.

If enabled, set Banner notifications permissions:

l Don't show notifications

l Only show me help notifications- personalized recommendations of Snagit features

l Show me help and promotional notifications- also receive news about events such
as training webinars

Automatically check
for updates

Automatically check or download the latest version of Snagit when connected to the
Internet.

Advanced Preferences

Option Description

Scale
down
retina
images
when
sharing

If you open an image captured on a Retina display on a regular monitor, the capture appears twice as

large as the same content captured on a regular monitor. This option scales down retina image captures

when you:

l Share an imagewith Snagit outputs.

l Drag images from Snagit Editor into another location.

If you frequently switch between sharing the original image and sharing the scaled down

image, hold the Shift key when dragging the image from Snagit into another location. Holding

the Shift key when dragging pastes an image opposite of the default behavior selected for this

option. For example, if this option is enabled, holding the Shift key pastes an image of the

original size captured.

Always
create
new
canvas
at this
size

Sets the default image dimensions when you select File > New Image (Command-N). If you enable this

option, the dialog to enter custom dimensions for a new imagewill not open.

Always
use
black

Select this option if you do not want to display the red Snagit menu bar icon when recording a video
capture.
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Option Description

and
white
menu
bar icon

Autosave
location

Unsaved image captures are stored as .snagproj files and video captures as .mp4 files in: User

name/Documents/Snagit/Autosaved Captures.

Click theChoose button to select another location.

Drag
and
paste
format

Set the default file format when dragging captures from Snagit Editor into another application or
location.

Turn
On/Off
Mobile
Sharing

You can import images and videos from a mobile device into Snagit Editor. Turn on this option to allow

sharing between a mobile device and Snagit. See Import Captures from a Mobile Device.

l Keep original image dimensions: Snagit automatically resizes mobile images for better viewing in
Snagit Editor. Enable this option to importmobile images at the original dimensions.

l Connection Name: TechSmith Fuse remembers each connection and allows you to choosewhich
instance of Snagit to send themobile images or videos. You can customize the name of each
connection to be sure you are sending the files to the correct computer running Snagit.

l Port: Port number for connecting TechSmith Fuse to Snagit.

Keyboard shortcuts allow you to press a combination of keys to quickly complete tasks in Snagit.

l Snagit Editor shortcuts

l Tool shortcuts

Snagit Editor Shortcuts

Option Keyboard Shortcut

Open Editor Command-Shift-E

Enter Full Screen Control-Shift-F

Open Preferences Command-comma

Hide Snagit Command-H
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Option Keyboard Shortcut

Quit Snagit Command-Q

New Image Command-N

New from Clipboard Shift-Command-N

Open Command-O

Close Snagit Command-W

Close Capture Shift-Command-W

Close All Option-Command-W

Save Command-S

Save As Shift-Command-S

Save All Option-Command-S

Print Command-P

Undo Command-Z

Redo Shift-Command-Z

Cut Command-X

Copy Command-C

Copy All Option-Command-C

Paste Command-V

Duplicate Shift-Command-D

Delete Delete key

Select All Command-A

Deselect All Command-D

Invert Selection Shift-Command-I

Jump to Next Frame Right arrow

Jump to Previous Frame Left arrow
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Option Keyboard Shortcut

Jump to Beginning Command-Return

Jump to End Shift-Command-Return

Draw a Perfect Square or Circle

Move or Draw an Object In a Line
Hold the Shift key while dragging.

Crop to Canvas Command-K

Trim Shift-Command-X

Flatten Shift-Command-T

Flatten All Control-Shift-T

Actual Size Command-0

Zoom to Fit Shift-Command-0

Zoom In Command-plus

ZoomOut Command-minus

Resize Image Shift-Command-R

Rotate Image Command-R

Switch to Library Command-1

Show/Hide Effects panel Command-2

Show/Hide Properties Command-3

Show/Hide Recent Captures Tray Option-Command-T

Next Capture in Tray Command-[

Previous Capture in Tray Command-]

Open Share History Option-Shift-S
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Tool Shortcuts

Option Keyboard Shortcut

Arrow and Line Control-A

Text Control-T

Callout Control-D

Shape Control-U

Fill Control-F

Stamp Control-I

Crop Control-C

Selection Control-L

MagicWand Control-W

CutOut Control-X

Pen Control-P

Highlighter Control-H

Step Control-S

Eraser Control-E

Blur Control-B

Move Control-V

Magnify Control-M
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Snagit Editor Preferences and Hotkeys

Preferences
To open the Snagit Editor Preferences, select Snagit Editor > Edit > Editor Preferences.

To learn more about the Editor options, view the following:

l General Tab

l Editor Tab

l Outputs Tab

l Library Tab

l Advanced Tab

General Tab

Options Description

Show OneClick

Displays the quick capture options as a tab at the top of the screen.

Hover the cursor over theminimized bar to expand thewindow.

Click and drag tomoveOneClick a different edge of your screen .

Snagit theme Choose between the two Snagit interface color themes: Light or Dark.

Show me onboarding
Disables the initial capture GIF and turns off onboarding light indicator in the upper-right
corner of Snagit Editor.
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Options Description

Send anonymous
usage data

Send anonymous data on Snagit usage to help TechSmith improve future versions.

If enabled, set Banner notifications level:

l Don't show me notifications

l Only show me help notifications- personalized recommendations of Snagit features

l Show me help and Techsmith promotions - also receive news about events such as
training webinars

Editor Tab

Options Description

Editor background color

Select the canvas background color.

If you are having trouble viewing your capture, change the background color
to increase the contrast between the application and the capture previewed
on the canvas.

Recent files thumbnail
size

Select the size of the capture thumbnails in the Recent Captures Tray.

Automatically expand
the canvas to fit objects

Automatically increase the size of an imagewhen pasting or dragging objects outside of
the current image.

Escape key closes Editor
Set the hotkey to close Snagit Editor to the Escape key.

This option is disabled by default.
Or select File > Exit Snagit Editor to exit.

Show cursor quick style
popup

Display a preview of the tool style next to the cursor on the canvas.

Show Toolbar Labels Choose to display icons and text labels or icons only in the Snagit Editor toolbar.
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Outputs Tab

Options Description

Disable image transparency on
clipboard

Remove transparent areas from image copied to the clipboard.

Some application, such as web-based email, may not support transparency

in pasted images.

Paste images as HTML for Outlook
Express

Paste images into Outlook Express using HTML to allow the image to display
correctly.

Embed images when sending email
(Outlook / Outlook Express only)

Snagit inserts the image directly into the body of an email message.

Embedding images requires the email client to use the HTML format.

When disabled, this option attaches the image to an email message.

Library Tab

Options Description

Maximum recent files
Enter themaximum number of captures to display at a time in the Recent
Captures Tray. Enter a number 1-15.

Automatically save new image
captures in the Library

By default, Snagit automatically saves new captures in the library. If this option
is disabled, any unsaved captures are closed and deleted when you close
Snagit.

Automatically save new video
captures in the Library

By default, Snagit automatically saves new captures in the library. If this option
is disabled, any unsaved captures are closed and deleted when you close
Snagit.

Prompt before deleting files Display a message prompt before deleting files in Snagit.

Remove all items from the tray
when closing Editor

Tray items are removed and the tray is empty when Editor opens again.

Library location
By default, the library files are located in this folder:
C:\Users\username\AppData\Local\TechSmith\SnagIt\DataStore\. To
change the location, click the Browse button.
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Advanced Tab

Options Description

Always keep Editor
running in the
background

Snagiteditor.exe remains running in Windows Task Manager even if you close Snagit
Editor. Enabling this option allows captures to open more quickly.

Delete cropped content Automatically delete the content cropped out of an image.

Automatically flatten
pasted images

In Snagit Editor, you can edit any objects on the canvas that have not been flattened.

Once an object has been flattened it is a permanent part of the image and cannot be

edited.

Mobile Sharing

Add a mobile device under File > Connect Mobile Device to enable this option and allow

image and video sharing between themobile device and Snagit. See Import Captures

from a Mobile Device.

l Keep original image dimensions: Snagit automatically resizes mobile images for
better viewing in Snagit Editor. Enable this option to importmobile images at the
original dimensions.

l Connection Name: TechSmith Fuse remembers each connection and allows you
to choosewhich instance of Snagit to send themobile images or videos. You can
customize the name of each connection to be sure you are sending the files to the
correct computer running Snagit.

Snagit Editor Hotkeys

Option Keyboard Hotkey

New Image CTRL+N

New Image from Clipboard CTRL+SHIFT+N

Open CTRL+O

Close ALT+F4

Close Current Capture
CTRL+F4

CTRL+W

Save CTRL+S
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Option Keyboard Hotkey

Save As CTRL+SHIFT+S

Print CTRL+P

Undo CTRL+Z

Redo CTRL+Y

Cut CTRL+X

Copy CTRL+C

Copy All CTRL+SHIFT+C

Paste CTRL+V

Delete CTRL+Delete

Select All CTRL+A

Bring Forward CTRL+SHIFT+F

Bring Backward CTRL+SHIFT+B

Group CTRL+SHIFT+G

Ungroup CTRL+SHIFT+U

Draw a Perfect Square or Circle

Move or Draw an Object In a Line
Hold the Shift key while dragging.

Duplicate CTRL+D

Flatten CTRL+F

Flatten All CTRL+SHIFT+T

Actual Size CTRL+0

Zoom In CTRL+Plus

ZoomOut CTRL+Minus

Open Help F1
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Toolbar Hotkeys
Hotkeys are assigned to the first ten positions in the Snagit Editor toolbar.

PressCTRL+1 through CTRL+9 to use the toolbar position hotkeys.
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Introduction à la bibliothèque Snagit
Snagit enregistre automatiquement l’historique des captures dans la bibliothèque, y compris les fichiers

ouverts ou modifiés dans Snagit Editor.

Pour accéder à la bibliothèque depuis Snagit Editor, cliquez sur le bouton Bibliothèque dans la partie

supérieure de Snagit Editor.

Les captures sont classées par catégories :

l Type de capture (Images, Vidéos, GIF animés)

l Captures récentes (Windows) : captures réalisées au cours des quatre dernières semaines, ainsi que tous
les fichiers visualisés ou enregistrés dans Snagit

l Date (année et mois)

l Applications : toutes les applications capturées par Snagit

l SitesWeb (Windows) : tous les sitesWeb capturés par Snagit

l Étiquettes : liste des étiquettes attribuées aux captures dans Snagit

Recherche de captures
1. Dans Snagit Editor, cliquez sur le bouton Bibliothèque.
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2. Entrez le terme à rechercher dans le champ Type de recherche. Vous pouvez effectuer la recherche par
nomde fichier, étiquette, application ou siteWeb ayant servi à la capture.

3. Les résultats de la recherche s’affichent sous le champ de recherche. Cliquez sur l’un des résultats pour
afficher les captures de la bibliothèque.

4. Pour ouvrir une capture dans le panneau, double-cliquez sur celle-ci dans la bibliothèque.

Navigation dans l’historique des captures
1. Dans Snagit Editor, cliquez sur le bouton Bibliothèque.

2. Les captures sont classées par date (mois et année), application, siteWeb ou étiquette. Cliquez sur l’une
des catégories dans le panneau de recherche pour afficher les captures de cette catégorie dans la
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bibliothèque.

3. Pour ouvrir une capture dans le panneau, double-cliquez sur celle-ci dans la bibliothèque.

Affichage de captures dans la bibliothèque
l SousWindows :

l Cliquez sur le bouton Vue détaillée ou Vue miniature pourmodifier l’affichage des
captures dans la bibliothèque.

l Cliquez sur le bouton Afficher les options de zoom et faites glisser le curseur de zoompour
modifier la taille desminiatures des captures dans la bibliothèque.
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l SurMac :

l Faites glisser le curseur de zoompourmodifier la taille desminiature des captures dans la
bibliothèque.

l Pendant une opération de capture, Snagit enregistre d’autres informations. Pour consulter ces
métadonnées :

l Windows : cliquez avec le bouton droit de la souris et sélectionnezDétails.

l Mac : appuyez sur la touche Ctrl en cliquant, puis sélectionnezAfficher les infos.

l Pour ouvrir une capture dans le panneau, double-cliquez sur sa miniature dans la bibliothèque.

Ajout d’une étiquette
Ajoutez des étiquettes aux captures afin de les regrouper ou d’effectuer des recherches plus facilement.

Les étiquettes sont uniquement visibles dans Snagit.

1. Dans Snagit Editor, sélectionnez une capture dans le panneau ou dans la bibliothèque.

Appuyez sur la touche Ctrl (Windows) ou Cmd (Mac) et cliquez sur plusieurs captures pour les

sélectionner.

2. Cliquez sur le bouton Étiquette.

3. Entrez une nouvelle étiquette ou cliquez pour sélectionner une étiquette existante dans la liste.
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Affichage des étiquettes
Snagit enregistre automatiquement l’historique des captures dans la bibliothèque. Dans le panneau de

recherche, cliquez sur la catégorie Étiquettespour afficher la liste de toutes les étiquettes appliquées aux

captures.
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Traduction de texte
L’option Traduire vous permet de créer rapidement des images en plusieurs langues. Snagit extrait le texte

source des annotations et légendes dans un fichier .xliff afin que vous puissiez envoyer celui-ci à votre

traducteur. Vous pouvez importer le fichier dans Snagit afin de générer automatiquement les images

traduites.

Extraction d’un texte à traduire
Suivez les étapes ci-dessous pour extraire le texte de légendes et d’annotations en vue de le faire traduire :

1. Dans la bibliothèque, sélectionnez des fichiers .snag ou .snagproj contenant des légendes ou des
annotations de texte.

2. Cliquez sur le bouton Traduire pour extraire le texte à traduire.

3. Dans le champ Extraire sous, entrez le nomdu projet.

Snagit étiquette les fichiers source avec le nomdu projet et une étiquette de langue afin que
vous puissiez rapidement localiser les images dans la bibliothèque.

4. Sélectionnez l’emplacement d’enregistrement du fichier .xliff.

5. Cliquez sur le bouton Extraire.

6. Envoyez le fichier .xliff à votre traducteur interne ou à un prestataire de localisation pour ajouter les
traductions dans les langues cibles.
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Importation de traductions
Après avoir ajouté les traductions dans le fichier .xliff, vous pouvez importer celui-ci dans Snagit Editor afin de

générer automatiquement les images traduites.

1. Dans Snagit Editor, sélectionnez Fichier > Traduire > Importer la traduction.

2. Sélectionnez le fichier .xliff contenant les traductions et cliquez surOuvrir.

3. Sélectionnez la langue traduite dans la liste déroulante et cliquez surOK.

Snagit génère automatiquement les images localisées à l’aide des traductions se trouvant dans le fichier .xliff.

Snagit étiquette les images traduites avec le nomdu projet et une étiquette de langue afin que vous puissiez

rapidement localiser les images dans la bibliothèque.

Révision d’images traduites
Après avoir importé le fichier .xliff dans Snagit Editor, la boîte de dialogue Revoir les traductions importées

s’ouvre.
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Pour examiner un élément :

1. Cliquez sur un message d’information, d’avertissement ou d’erreur dans cette boîte de dialogue pour
ouvrir le fichier dans le canevas.

2. Examinez et modifiez le fichier .snag, .snagproj ou .xliff en fonction du message.

3. Répétez cette opération pour l’erreur ou l’avertissement suivant dans la liste.

Informations
Lesmessages d’information fournissent des informations supplémentaires sur l’image localisée.

Message Action de l’utilisateur

Aucun problème détecté. Aucune action n’est nécessaire.

La légende a été redimensionnée
pour s’adapter à la traduction.
(Mac)

Le texte traduit est trop long pour la taille de la légende d’origine. Snagit

redimensionne automatiquement la légende en fonction de la longueur de la

traduction.

Cliquez sur lemessage pour afficher un aperçu des modifications dans le

canevas.

Suggestions de modification :

l Vérifiez que la légende ne recouvre pas de contenu important de l’image.
Pour déplacer la légende, cliquez dessus et faites-la glisser vers un nouvel
emplacement.
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Message Action de l’utilisateur

l Pour redimensionner la légende, faites glisser les poignées blanches.

l Sélectionnez le texte dans la légende etmodifiez la taille de police.

Texte localisémis à jour avec la
nouvelle traduction.

Il existe une version précédente de l’image localisée. Snagitmet

automatiquement à jour l’image localisée à l’aide de la nouvelle traduction

fournie par le fichier .xliff.

Cliquez sur lemessage pour afficher un aperçu des modifications dans le

canevas.

 Avertissements
Les avertissements signalent des éléments à revoir dans le fichier .snag, .snagproj ou .xliff.

Message Action de l’utilisateur

Le texte source a changé depuis
l’extraction.

Le texte source du fichier d’origine a changé depuis l’extraction du texte à

traduire. La traduction importée est peut-être obsolète.

La légende ou zone de texte ne se
trouve pas dans l’image d’origine.

La légende ou l’annotation de texte a été supprimée de l’image d’origine.

Cliquez sur lemessage pour afficher un aperçu des modifications dans le

canevas.

Il manque du texte traduit pour les
éléments X. (Windows)

1. Vérifiez que la traduction a été ajoutée au fichier .xliff.

2. Mettez à jour le fichier .xliff à l’aide des traductions.

3. Sélectionnez l’option Fichier > Traduire > Importer la traduction, puis
sélectionnez le fichier mis à jour.

Le fichier importé ne contient pas de
traduction. (Mac)

1. Vérifiez que la traduction a été ajoutée au fichier .xliff.

2. Mettez à jour le fichier .xliff à l’aide des traductions.

3. Sélectionnez l’option Fichier > Traduire > Importer la traduction, puis
sélectionnez le fichier mis à jour.

Le fichier source contient des
légendes supplémentaires.

Snagit a détecté un ajout de nouvelles légendes ou annotations de texte au

fichier .snag ou .snagproj après l’extraction du texte à traduire.

Aide de Snagit | 107

https://www.techsmith.com/


 Erreurs
Lesmessages d’erreur s’affichent lorsque l’importation n’a pas réussi ou que des problèmes sont survenus et

doivent être résolus.

Message Action de l’utilisateur

Les données importées ne sont pas
valides.

Pour résoudre ce problème, vérifiez les éléments suivants dans le fichier

.xliff :

l Exécutez le fichier .xliff dans un valideur pour identifier tout code non
valide.

l Vérifiez que ce fichier est conforme aux spécifications de la version 2.0
de XLIFF.

l Supprimez le formatage lorsque vous copiez les traductions dans le
fichier .xliff.

l Vérifiez que vous avez ajouté une traduction pour chaque entrée de
texte source.

Après avoir mis à jour le fichier .xliff, sélectionnez l’option Fichier >

Traduire > Importer la traduction pour importer le fichier mis à jour.

Impossible de créer un fichier de
traduction.

Vérifiez que vous disposez des autorisations adéquates et que l’espace

disque est suffisant.

Fichier introuvable. Le fichier a peut-
être été déplacé ou supprimé.

Snagit ne retrouve pas le fichier .snag ou .snagproj d’origine. Ce fichier a

peut-être été déplacé ou supprimé.
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Partage de captures
Partagez rapidement vos images ou vidéos à l’aide des destinations Snagit.

1. Dans Snagit Editor, cliquez pour sélectionner une capture dans le panneau.

2. Cliquez sur le bouton Partage et sélectionnez une destination.

Snagit désactive les destinations qui ne prennent pas en charge le format du fichier ou la capture

sélectionnée dans le panneau.
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Destinations par défaut

Destination Image Vidéo

Fichier

Enregistrez une capture d’image ou vidéo dans un emplacement de fichier.

E-mail

Insérez la capture d’image dans un nouveau message e-mail.

FTP

Envoyez la capture sur un serveur FTP en utilisant le protocole de transfert de fichiers.

Programme (Windows)

Envoyez la capture vers un autre programme. Effectuez une sélection dans une liste de

programmes prenant en charge le format de fichier de la capture.

Presse-papiers (Windows)

Copiez la capture dans le Presse-papiers Windows pour la coller rapidement à un autre

emplacement ou dans une autre application.

Imprimante (Windows)

Envoyez la capture d’image vers une imprimante.

Microsoft Word

Insérez une capture d’image dans un documentMicrosoft Word. Pour personnaliser les options

de destination MicrosoftWord, sélectionnez le bouton Partage > liste déroulante Word >

Options (Windows).

Si vous n’avez pas préalablement ajouté les destinations Microsoft, cliquez sur le

bouton Partage et sélectionnez Plus de destinations Snagit. Cliquez sur le bouton

d’ajout et sélectionnez la destination Microsoft voulue dans la liste.

Microsoft Powerpoint

Insérez la capture d’image dans une diapositive de présentation PowerPoint. Pour personnaliser

les options de destination Microsoft PowerPoint, sélectionnez le bouton Partage > liste

déroulante PowerPoint > Options (Windows).
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Destination Image Vidéo

Si vous n’avez pas préalablement ajouté les destinations Microsoft, cliquez sur le

bouton Partage et sélectionnez Plus de destinations Snagit. Cliquez sur le bouton

d’ajout et sélectionnez la destination Microsoft voulue dans la liste.

Microsoft Excel

Insérez une capture d’image dans un classeur Microsoft Excel. Pour personnaliser les options

de destination Microsoft Excel, sélectionnez le bouton Partage > liste déroulante Excel > Options

(Windows).

Si vous n’avez pas préalablement ajouté les destinations Microsoft, cliquez sur le

bouton Partage et sélectionnez Plus de destinations Snagit. Cliquez sur le bouton

d’ajout et sélectionnez la destination Microsoft voulue dans la liste.

Screencast.com

Téléchargez une image ou vidéo dans Screencast.com en vue de son hébergement.

Screencast.com fournit une URL à partager rapidement ou un code intégré permettant d’ajouter

la capture à un siteWeb ou un blog. Pour personnaliser les options de destination, sélectionnez

le bouton Partage > liste déroulante Screencast.com > Options.

Si vous n’êtes actuellement pas connecté à votre compte TechSmith, connectez-vous

ou créez un compte. Voir À propos des comptes TechSmith.

Camtasia

Utilisez Camtasia dans les cas suivants :

l Importer des images fixes ou des vidéos pour les utiliser comme fichiers source dans des
projets Camtasia.

l Améliorer les captures vidéo enregistrées dans Snagit à l’aide de légendes, de texte, de
titres, de sous-titres, d’effets, etc.

Snagit importe la vidéoMP4 ou le fichier image dans le chutier de Camtasia.

Vous devez disposer de Camtasia 7.0 (Windows)/2.0 (Mac) ou une version ultérieure

pour utiliser cette destination de partage des captures.
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Destination Image Vidéo

TechSmith Relay

Téléchargez une image ou une vidéo dans TechSmith Relay.

YouTube
Téléchargez la capture vidéo sur votre compte YouTube YouTube fournit une URL pour un

partage rapide avec les spectateurs ou un code intégré pour ajouter la capture à un siteWeb ou

un blog.

YouTube redimensionne la vidéo pour qu’elle respecte ses dimensions standard. Pour des

résultats optimum, enregistrez la vidéo en respectant les dimensions recommandées de

YouTube.

Google Drive

Téléchargez la capture sur Google Drive pour l’hébergement des images ou vidéos. Un lien vers

la capture est copié dans le Presse-papiers.

1. Si vous ne vous êtes pas connecté à votre compte Google au préalable, la boîte de
dialogue Google Drive s’ouvre. Entrez votre e-mail et votremot de passe, puis cliquez sur
Se connecter.

2. Cliquez sur Autoriser. La boîte de dialogue Send to Google Drive s’affiche.

3. Entrez un nom de fichier, sélectionnez le dossier de la capture à télécharger et cliquez sur
Télécharger.

Pour personnaliser la destination :

l Windows : sélectionnez Partage > liste déroulante de la destination > Options.

l Mac : sélectionnez Partage > Plus de destinations Snagit. Cliquez pour sélectionner la
destination dans la liste.

Dropbox
Téléchargez la capture sur Dropbox pour l’hébergement des images ou vidéos. Un lien vers la

capture est copié dans le Presse-papiers.

OneDrive for Business

Téléchargez la capture vers Microsoft OneDrive for Business pour y accéder à toutmoment sur

l’ordinateur ou appareil de votre choix.

Téléchargement de destinations supplémentaires
Vous pouvez télécharger d’autres destinations en ligne.

l Windows : sélectionnezPartage > icône des propriétés  > Préférences de destination.

l Mac : sélectionnezPartage > Plus de destinations Snagit.
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l Sous l’onglet Destinations, cliquez sur l’icône au bas de la boîte de dialogue des préférences de
Snagit Editor.

Ajout d’une nouvelle destination Mac
Vous avez la possibilité de personnaliser les éléments suivants pour les destinations Mac :

l Enregistrer ou modifier les paramètres de compte

l Définir plusieurs comptes pour unemême destination, par exemple, un compte professionnel et un
compte personnel

l Créer un nomde destination personnalisé

1. Sélectionnez Snagit > Préférences > onglet Destinations.

2. Cliquez sur le bouton d’ajout et sélectionnez une destination dans la liste.

3. Entrez le nomde la destination.

Si vous définissez plusieurs comptes pour unemême destination, veillez à entrer un nom

unique pour chacun d’eux, par exemple, Twitter-travail et Twitter-perso.

4. Personnalisez les paramètres de la destination.

5. Fermez la boîte de dialogue des préférences.
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Suppression d’une destination
1. Dans Snagit Editor :

l Windows : sélectionnezPartage > icône des propriétés > Préférences de destination.

l Mac : sélectionnez Snagit > Préférences > onglet Destinations.

2. Sélectionnez la destination à supprimer et cliquez sur le bouton de suppression.

Ajout d’extensions Mac
Vous avez la possibilité d’ajouter, dans lemenu Partage, des extensionsMac tierces proposées par le système

d’exploitation Apple en tant que destinations de partage.

1. Dans Snagit Editor, cliquez sur le bouton Partage et sélectionnezPlus.

2. La boîte de dialogue Extensions s’affiche. Cliquez surMenu Partager et sélectionnez les extensions à
utiliser dans Snagit.

3. Fermez la boîte de dialogue Extensions.
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Ressources complémentaires -
Snagit 2019
Le fichier d’aide de Snagit est maintenant disponible en ligne pour la version 2019. L’aide en ligne vous aide à

faire vos premiers pas dans Snagit et à trouver des réponses à vos questions.

Avez-vous trouvé ce que vous recherchiez dans l’aide en ligne ? Si tel n’est pas le cas, consultez l’une des

autres ressources que nous proposons :

l Didacticiels de Snagit : formation gratuite sous forme de vidéos, didacticiels et guides.

l Articles d’assistance technique : consultez nos articles d’assistance en cas de problème ou contactez un
expert.

l Communauté :obtenez de l’aide auprès de la communauté des utilisateurs de TechSmith.

l Ressources d’entreprise : ressources et guides pour administrateurs, pour les aider à déployer et à
personnaliser les installations Snagit.
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